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Introduction 
 

Many people suffer from Alzheimer’s disease (AD), a disease that gradually destroys 
memory along with other vital functions. Symptoms of AD include but are not limited to, the 
inability to form new memories, depression and increased difficulty in performing everyday 
activities related to daily living (Burns & Iliffe, 2009). While there is no known cure for AD and 
definitive diagnosis is only achieved post-mortem, it is known that one of the causes of neural 
cell death leading to the onset of AD is β-amyloid plaque. These plaques are formed by the 
build-up of β-amyloid in between the cells of the brain (Burns & Iliffe, 2009). β-amyloid plaque 
is an extracellular aggregation of fibrous protein built up in layers (Kandel, Schwartz, Jessell, 
Siegelbaum & Hudspeth, 2013). One region of the brain that is particularly prone to this build-up 
of excess protein is the hippocampus (Kandel et al., 2013), which is involved in storing 
memories and thus, is linked to AD (Erickson et al., 2011).  
 AD researchers have focused on developing treatments that decrease the accumulation of 
the plaque directly by creating ways of breaking down β-amyloid as it is being produced so none 
of it lingers around the cells long enough to cause a build-up (Kandel et al., 2013). One approach 
that has been investigated is the induction of autophagic activity. Autophagy is the process by 
which non-functional molecules within a cell, such as proteins, are degraded through the use of 
lysosomes to maintain homeostasis (Lipinski et al., 2010). When neurons are exposed to β-
amyloid, autophagosomes begin to aggregate in damaged areas of neurons. Accumulation of 
autophagosomes implies little autophagic activity, which suggests a correlation between 
increased β-amyloid plaque and reduced autophagic activity (Lipinski et al., 2010).   

The next step in this area of research is to find a way to enhance autophagy to a point 
where it will bring neurons back to homeostasis and proceed with its prominent function of 
digesting unnecessary material in the cell by the use of lysosomes. This may promote survival of 
the neurons such that prevention of Alzheimer’s may be a possibility. However when autophagic 
activity reaches a certain level, it becomes a factor that stimulates cell death (Lipinski et al., 
2010). Therefore, it is important to produce the ideal conditions within each neuron where there 
is the correct amount of autophagy without decreasing viability. 

The optimal level of autophagy within a neuron may be found by using inducers of 
autophagy at varying doses to ultimately define an alternate treatment, and perhaps even 
prevention, for Alzheimer’s disease through the use of different therapies. An inducer of 
autophagy used within this study is resveratrol (Marambaud, Zhao, & Davies, 2005). Resveratrol 
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is a molecule that is found in the skins of a range of edible plants, such as grapevines and 
pomegranates, and thus may be an alternative, natural treatment of Alzheimer’s disease (Ahmed 
et al., 2016). The hypothesis tested in this study is that resveratrol will cause a dose-dependent 
increase in autophagic activity in neurons, as measured by the brightness of lysosomes within 
neurons. In this study, we tested this hypothesis by treating chick sympathetic neurons with 
resveratrol solutions and labeling the cells with fluorescence to analyze the brightness of 
lysosomes. From this point, it may be possible to propose a better, more tolerable treatment for 
Alzheimer’s patients that will cause little to no adverse effects. 
 
 
Materials and Methods 
 
Primary Culture 
 The primary cell tissue culture was performed on ten-day old Gallus gallus neurons and 
glia as described by Morris (2015a). Coverslips containing high-density areas of single cells 
were used for imaging and analysis. 
 
Preparation of Resveratrol Solutions 
 A 10mg/mL stock of resveratrol (R5010-100MG) in DMSO was prepared, first by 
massing 10mg resveratrol and adding 1mL DMSO by pipetting. The falcon tube was inverted to 
mix. A 1X working solution of 40uM (Marambaud, Zhao, & Davies, 2005) was created, by 
pipetting 7.36uL 10mg/mL resveratrol stock in 8mL growth medium. The falcon tube was then 
inverted to mix. The highest concentration of solution (20uM) (Marambaud, Zhao, & Davies, 
2005) was created by pipetting 2mL of the working solution into 2mL growth medium to make a 
4.6ug/mL solution of resveratrol. The falcon tube was inverted to mix. The lowest concentration 
of solution (10uM) (Marambaud, Zhao, & Davies, 2005) was made by pipetting 1mL of the 
working solution into 3mL growth medium to create a 2.3ug/mL solution of resveratrol. Solution 
doses were selected based off of prior evidence that the highest concentration would not induce 
apoptosis and the lowest dose would induce some autophagy shown through the decrease in β-
amyloid (Marambaud, Zhao, & Davies, 2005).  
 
Experimental and Control Conditions 
 Four experimental coverslips and two control coverslips were used in this experiment. 
Coverslips were incubated at 37°C for 24 hours in growth medium (Marambaud, Zhao, & 
Davies, 2005). Two of the coverslips were then imaged as a control for autophagy as indicated 
by lysosomal brightness. For the remaining four coverslips, growth medium was removed 
completely. 2mL of the highest concentration of resveratrol was applied to two of the coverslips. 
Likewise, 2mL of the lowest dose was applied to the other two coverslips (Prager, 2016). These 
four coverslips comprise the experimental group. The experimental group was incubated for 
another 24 hours at 37°C to complete the resveratrol treatment (Marambaud, Zhao, & Davies, 
2005). Note that both control coverslips and two experimental coverslips were prepared in one 
week, and the other two experimental coverslips were prepared two weeks later. Also, all 
experimental coverslips received the same treatment. Two trials were completed for this 
experiment. 
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Staining of Cells 
 A staining method requiring the fluorescent dye called LysoTracker Green DND-26 was 
used to view lysosomes in neuronal cells as developed by Keran Yang (ThermoFisher, n.d.). It 
was diluted to 60nM by pipetting 1uL in 16.7mL HBSS and was stored in a falcon tube wrapped 
in aluminum foil to shield the solution from the light. The cells were washed for 2 minutes with 
warm HBSS, which was heated to 37°C for 5 minutes in a water bath before use. All solution 
was then removed from the petri dish and 1mL lysotracker was added with limited exposure to 
the light. The cells were covered with aluminum foil and incubated for 5 minutes at 37°C. The 
lysotracker was then removed. The cells were gently washed with HBSS three times for 1.5 
minutes. Some HBSS was left on the cells after the third wash to prevent them from drying out 
while chip chambers were prepared. Slides were covered with aluminum foil until imaging to 
minimize exposure to light. 
 
Observing Live Cells Using Chip Chambers 
 Cell observations were done as described by Morris (2015b), with the following 
modifications. HBSS solution was used in place of the growth medium from the petri dish to 
place the coverslip onto to ensure further application of resveratrol did not occur during 
observations. The liquid from the petri dish was a solution of resveratrol, growth medium and 
DMSO, not pure growth medium. 
 
Fluorescent Microscopy and Imaging 
 Observations of the cells were made in the Imaging Center for Undergraduate 
Collaboration (ICUC) at Wheaton College using an upright Nikon Eclipse E200 Microscope 
with a Nikon microscope 1.0x C-mount. A Spot Insight FireWire 2 camera was connected to the 
C-mount. Imaging was completed using Spot software, version 5.2, on an Apple iMac Macintosh 
computer, OSX Yosemite, version 10.10.5. Precautions were made to prevent the microscope 
lens from contacting with the VALAP on the chip chambers.  
 
Image Analysis 
 Four transmitted images along with four corresponding fluorescent images from each 
sample were captured. These images contained distinct neuron cell bodies to avoid overlap of 
cells when marking area guides around them using ImageJ software. An image was opened in 
ImageJ (File>Open>Image). Next, measurements were set to the same settings (Analyze>Set 
Measurement) by ensuring that the following options were selected: Check Area, Min & max 
gray value, Integrated density, Display label, Redirect to>none and Decimal places>3. Images 
were then magnified to isolate one neuronal cell before using the freehand tool to draw an area 
guide around the entire cell. This was done to avoid including any measurements from outside 
the cell being included in the data. The image type was then changed to an 8-bit grayscale image 
(Image>Type>8-bit) to simplify the processing of the image. The minimum and maximum 
thresholds were set to 34 and 255 respectively (Image>Adjust>Threshold) so that only pixels 
brighter than the threshold would be included in the data thus excluding background from the 
measurements. The minimum threshold was determined from the control images where the most 
area of a neuron containing lysosomes was selected for measurement. The number of pixels 
above 34 to be measured was set to be within the range of 1-inf (Analyze>Analyze particles) 
with the following options selected: Display results, Clear results, Summarize and In situ show. 
The percent area (number of pixels covered by the threshold) in the summary window was used 
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for further processing. Note that the brighter the fluorescence image, the more active the 
lysosomes. This procedure was performed for each image and each neuron within the image. The 
use of ImageJ to analyze all images was described as per Karen Yang’s instruction. 
  
 
Results 

 
Pixels with the least brightness were observed in the images of the control (Fig. 1). It was 

observed that there were brighter fluorescent pixels in the images of the cells exposed to the 
lowest dose of resveratrol (Fig. 2). Figures 1-3 show images indicating lysosomal activity in 
single neuron cells, labeled with LysoTracker Green allowing all lysosomes to appear as green 
fluorescent spots in each image. Figure 4 shows the average percent area of neuronal cells 
containing lysosomes with brightness above a threshold of 34. The highest variation in the data is 
in the highest dose of resveratrol and the lowest variation is in the control, with the lowest dose 
containing a slightly higher variation than the control (Fig. 4).  
 
 
A.           B. 

 
Figure 1. Gallus gallus neurons exposed to control conditions. Magnification at 40x with phase 
2 settings. (A) Transmitted image of two neurons, circled in black. (B) Fluorescence image of the 
same two neurons as in A labeled with LysoTracker Green with exposure time of 15s. Note that 
although the neurons are brighter than the axons, the fluorescence is very dim in this control 
image. Imaged with SPOT Basic software, version 5.2. Images captured in collaboration with 
Cynthia Mercedes. 
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A.              B. 

 
Figure 2. Gallus gallus neurons exposed to lowest dose of resveratrol (2.3ug/mL). Magnification 
at 40x with phase 2 settings. (A) Transmitted image of three neurons, circled in black. (B) 
Fluorescence image of the same three neurons as in A labeled with LysoTracker Green with 
exposure time of 15s. Note that neurons appear brighter than glial cells or axons. Fluorescence in 
this image is very bright. Imaged with SPOT Basic software, version 5.2. 
 
 
A.          B. 

 
Figure 3. Gallus gallus neurons exposed to highest dose of resveratrol (4.6ug/mL). 
Magnification at 40x with phase 2 settings. (A) Transmitted image of two neurons, circled in 
black. (B) Fluorescence image of the same two neurons as in A labeled with LysoTracker Green 
with exposure time of 15s. Note that although neurons are visible, the fluorescence is quite dim 
in this image. Imaged with SPOT software, version 5.2.  
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Figure 4. Mean Percent Area of Single Neurons Containing Lysosomes Exposed to Varying 
Concentrations of Resveratrol. This graph displays the mean percent area (%) of single neurons 
containing lysosomes with pixels brighter than the threshold of 34. The n-value for the control 
samples is n=7 neurons from three images in one trial. For the low dose samples, n=12 neurons 
from four images in one trial. The high dose samples had an n-value of 5 neurons from three 
images in one trial. Error bars indicate the standard variability and were calculated as described 
by NCSU in Using Error Bars in your Graph (2005). 
 
 
Discussion 

 
The data collected suggests that resveratrol increases autophagic activity. Both of the 

experimental doses produced an increase in percent area of neurons covered by lysosomes 
compared to the control dose (Fig. 4). However, contrary to the hypothesis, the data show that 
the lowest dose of resveratrol yields the most autophagy and therefore does not support the 
hypothesis (Fig. 4). Note that these data are preliminary. Several trials should be completed in 
future experiments to decrease statistical variation, as well as to increase the power of the data. 

Had this experiment been replicated several times and produced the same results, it 
would suggest that 2.3ug/mL resveratrol induces the most autophagy as indicated by the highest 
brightness of fluorescence produced by a higher level of lysosomal activity. It would also 
suggest that 2.3ug/mL resveratrol should be investigated further because it would be of particular 
interest in the field of AD research. 
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One source of variability in the data may originate from the data analysis using ImageJ. 
Although cell guides were placed carefully, it was difficult to determine the exact outline of a 
cell meaning that some bright fluorescence pixels may have been left out of the area being 
measured if any were above the threshold brightness. The opposite is also true. However, this 
was not observed during analysis, which reduces the probability of this error affecting the overall 
results. 
 Another source of variability is that some neurons that were imaged had no pixels that 
were above the brightness threshold, which may have affected processed data by decreasing 
processed values if the n-values were not high enough. This is because one value in that group of 
data had a larger effect on final averaged results than if 100 values had been collected.  
 Future work in this area would involve testing whether resveratrol affects neurons in 
other ways. One example of this is to analyze the level of lysosome rupture after applying 
different doses of resveratrol (Mrschtik and Ryan, 2015). If the induction of autophagy is by 
resveratrol, there may be a point in which the level of autophagy is too high. At a high level, 
autophagy can cause lysosome rupture and then cell death. Another example would be to test if 
resveratrol affects the break down of the contents in autophagosomes (Eskelinen and Saftig, 
2009). Fully functioning lysosomes can break down the contents of autophagosomes, thus 
reducing and preventing their build-up, which could link to the experiments relating to how to 
prevent the build-up of β-amyloid plaque. Future work in this area could involve the application 
of resveratrol to neurons pre-treated with varying concentrations of β-amyloid. These types of 
studies are important in working towards finding safer treatments for Alzheimer’s. For example, 
it could be possible that a change in diet that includes more natural ingredients containing 
resveratrol would be enough to prevent or combat the onset of Alzheimer’s Disease with 
decreased adverse effects on the body. 
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